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PREFACE 

The journey toward achieving the goal of delivering quality education demands 
unwavering commitment at both the state and organizational levels. The Quaid-e-Azam 
Academy for Educational Development (QAED) has been entrusted with a paramount 
mission: the development of high-quality professional development programs to 
empower teachers and school leaders across Punjab. 

In this educational landscape, ICT remains an essential cornerstone, intricately woven 
into the very scheme of study for all promotional link training and induction training 
programs delivered by QAED. It's important to understand that training teachers in ICT 
skills goes beyond keeping up with technological trends; it's a fundamental driver for 
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improving the quality of education and preparing students for the future. ICT 
skills empower teachers to deliver instruction that is not only more engaging, but also 
personalized and highly effective, streamlining their teaching practices for greater 
efficiency. Consequently, this contributes to better educational outcomes, providing 
students with the skills they need to thrive in the digital age. 

The module at hand stands as an integral component of our commitment to equip our 
teachers with essential ICT skills. Its primary objective is to enhance the capacities of 
both teachers and education managers, enabling them to proficiently utilize ICT skills to 
elevate the quality of their instruction and assume leadership roles as digitally 
empowered school leaders. This module is a significant step in building and enhancing 
the ICT skills of our educators and leaders. 

QAED wholeheartedly recognizes and appreciates the invaluable contributions made by 
all developers and reviewers who played a pivotal role in crafting this training module. 

I sincerely believe that this manual will effectively impart the ICT knowledge and skills 
necessary for teachers and education managers to elevate their capabilities and make a 
significant impact on educational practices. It is with great anticipation that we embrace 
this transformative step toward a brighter educational future, one where our educators 
and leaders are truly empowered in the realm of ICT. 

 
 
 

Sarah Rashid 
Director General QAED 
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Quaid-e-Azam Academy for Educational Development, 

Punjab, Pakistan 

ICT MODULE SESSION DETAILS 

 

Module Number Title No. of Sessions 

Pre Learning Activity 
Learn the mouse and Keyboard 
Proficiency 
 

 

Module 1 Microsoft Word 5 

Module 2 Microsoft PowerPoint 2 

Module 3 Microsoft Excel 3 

Module 4 Use of Internet  1 

Module 5 Microsoft Teams 2 
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Module 6 Social Media Applications 1 

Learning Activities Hands on Practice and Learning 
Assessment  

1 

Reading Material Digital Citizenship  

 

 

 

 

 

 

 

 

 

 

 

 

 

RATE YOUR ICT SKILLS 

 

Where would you put yourself on Proficiency Spectrum? 

 

 

 

  
  

                  

   1        2       3        4       5        6       7      8        9      10 
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Learn the Mouse & 
Keyboard Proficiency   
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        Learning Objectives: 

 
Upon completing this session, participants will be able to 
 

● demonstrate proficient use of the computer mouse for efficient navigation,    selection, 
and interaction with on-screen elements and  writing in a variety of software 
applications 

● Understand the purpose of a keyboard and the functions of its keys for effective 
computer input and text manipulation 

 

 

Pre- Learning Activity                   30 Minutes 
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What is computer Mouse? 

 
A computer mouse is a pointing device that allows you to interact with your computer's graphical 
user interface (GUI) by moving a pointer on the screen. It's like a magic wand that lets you click, 
select, and manipulate objects on your computer screen. With a mouse, you can perform 
different tasks like opening programs and files to navigating websites and playing games. Let’s 
learn first about its parts, actions and its handling.  

Parts of Computer Mouse 

 
 
 
 
 
 
 
 
 
 

 
 
 
 

How to Hold a Mouse Properly? 

● Place your palm on the base of the mouse. 

● Put your thumb on the side of the mouse. 

● Put your index finger on the left button. 

● Put your middle finger on the right button. 

● Put your remaining fingers on the far side of 
the mouse. 

● Your wrist should be straight, following 
the angle of your arm and not twisted to 
either side or higher or lower. 

 
 
 
 

Some common actions you can perform 
with a mouse: 

https://askatechteacher.com/how-to-teach-mouse-skills-to-pre-keyboarders/
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Computer Keyboard and its Parts 

A computer keyboard is an input device that allows users to enter text, numbers, and various 
commands into a computer. It is the primary input device used to interact with a computer. 
Keyboards come in various layouts and designs, with the most common layout being the 
QWERTY keyboard. 

 

 

 

 

 

 

 

 

 

Alphanumeric Keys These keys include letters (A-Z), numbers (0-9), and symbols 
commonly used for typing text and numbers. 

Pointing Click Double Click 

Click- Drag-Drop 

 

 

Alphanumeric Keys 
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Function Keys The top row of keys (usually labeled as F1, F2, etc.) serves as 
function keys, which can perform specific tasks or trigger 
functions within software applications. 

Cursor and Navigation 
Keys 

These keys (e.g., arrow keys) are used to move the cursor within 
documents, web pages, or other content and navigate through 
menus and interfaces. 

Numeric Keypad Located on the right side of many keyboards, the numeric keypad 
provides a convenient way to enter numbers and perform 
mathematical calculations. 

Multimedia Keys Some keyboards include additional keys for special functions like 
volume control, media playback, and shortcuts to common tasks. 

Escape Key (Esc) Often used to exit or cancel operations within software or to 
access certain functions in command-line interfaces. 

Enter/Return Key Used to confirm selections or execute commands, such as 
submitting forms or starting a new paragraph in text documents. 

Backspace and Delete 
Keys 

These keys are used for removing characters or items, either by 
erasing the character to the left (Backspace) or deleting the 
character to the right (Delete). 

Spacebar The largest key on the keyboard, it's used for inserting spaces 
between words and elements. 
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Microsoft Word 
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Upon completing this session, participants will be able to 

proficiently demonstrate the following Microsoft Word skills 

 

1. Introduction to MS Word: 

o Explain the purpose and importance of 

Microsoft word in document processing. 

o Explain the uses of Microsoft Word in 

teaching. 

2. How to Launch Microsoft Word: 

● Launch Microsoft Word using various methods, 

including desktop shortcuts and the Start menu. 

● Create a new blank document from scratch. 

3. Interface of MS Word: 

▪ Identify and describe the main components of the             

Microsoft Word interface, including the ribbon, Quick     

Access Toolbar, and document workspace. 

▪ Navigate the interface with ease, locating various  

commands and tools. 

4. How to Add & Copy Text: 

● Enter text into a Word document using the keyboard. 

● Copy Paste & Cut Paste. 

5. Text Formatting: 

● Apply Font formatting. 

● Apply Paragraph formatting. 

● Apply different Headings styles. 

 

 

 

 

Learning Objectives: 

  

SESSION- 1 Introduction to Microsoft Word         90 Minutes 
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Microsoft Word (MS Word) is a popular word processing software application developed by 
Microsoft Corporation. 

Common Uses 

Microsoft Word is designed to create, edit, format, and save documents such as letters, reports, 
essays, resumes, and more. 

How I will use Microsoft Word as teacher or School leader? 

A teacher can use Microsoft Word for a variety of tasks related to lesson planning, teaching, and 
administrative work. Here are some ways a teacher can use MS Word: 

As a Teacher: Creating Lesson Plans, Handouts, CV’s, Worksheets, Student Reports and Study 
Guides. 

As a School Leader: Creating Staff statements and School Calendar, Professional report writing 
and documentation, Students Record lists and Appreciation Certificates etc. 

  How to Launch Microsoft Word? 

 

▪ On bottom left corner of computer 
Screen (Desktop) click on Start 
button. 

▪ From Start menu select Microsoft 
Office and then select Microsoft 
Word. OR 

▪ Search Microsoft Word from search 
bar. OR 

▪ Click on shortcut icon of Microsoft 
Word available on desktop. 

▪ Click on the New>Blank document to 
create new document. 

 

 

 

Interface of Microsoft Word (2019) 

After clicking New Blank Document the working window of MS Word appears. 

 

 

SESSION-1  Introduction To Microsoft Word         90 minutes 
Minutes 
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All recent versions of Word include the Ribbon and the Quick Access Toolbar, where you'll find 
commands to perform common tasks in Word. 

Some Important parts of MS Word Interface are: 

▪ Title Bar: The Title Bar displays the name of the document you are currently 
using. 

▪ The Ribbon: 
 

The Ribbon contains multiple tabs, which you can find near the top of 
the Word window. Each tab contains several groups of related 
commands. 

▪ The Quick 
Access Toolbar: 

Located just above the Ribbon, the Quick Access Toolbar lets you 
access common commands like Save, Undo, and Redo. 

▪ The Ruler: The Ruler is located at the top and to the left of your document. It makes 
it easier to adjust your document with precision. 

▪ Scroll Bar: It allows you to move the view contents up and down or left and right. 
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How to add Text in Microsoft Word? 

 

▪ Place the cursor in document area  
where you want to add the text. 
 

▪ Start typing. 

 

 

Selecting the Text 

Before applying any formatting to text, we must select the text. We can select the text by: 

▪ Placing the mouse curser on start of the text and press and hold the left click button and 
move the mouse to the end of the text and release the mouse button. 

▪ To select a single word, double-click it. 
▪ To select a paragraph, triple click on paragraph. 

 

Text Formatting 

Formatted text can draw the reader's attention to specific parts of a document and emphasize 
important information. In Word, you have several options for adjusting text, including font, size, 
and color of the text. You can also adjust the alignment of the text to change how it is displayed 
on the page. 

Font Size: You can change the desired size of your font by clicking on Font Size drop down 
menu on Home tab. 

Bold: If you want to emphasize on a text, 

click B icon located on the Font group  

on the Home tab.        

The selected text will be Bold. 

Italic: Italic is a style of font that slants the letters                                         
evenly to the right. To make your text Italic click                                   
on I located on the Font group on the Home tab. 

Underline: If you want to underline a text click U icon located on the Font group on the Home 
tab. 

  

Font Size 

Bold 
Underline Font Color 

Italic 
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Copy Formatting 

▪ Select the text with the formatting you want to copy. 

▪ Click  Format painter, and then select the text you want to copy the formatting to. 

Text alignment is a paragraph formatting attribute that determines the appearance of the text 
in a whole paragraph. 

▪ By default, Word aligns text to the left margin in new documents. 
▪ However, there may be times when you want to adjust text 

alignment to the center or right. 
▪ Alignments are located on the Home tab on Paragraph group. 

Bullets & Numbering 

Bulleted and numbered lists can be used in your documents to: 

▪ Outline, arrange & emphasize text. 
▪ Bullets & Numbered lists are located on the Home tab on Paragraph group. 

 

 

 

 

 

 

 

 

Line and Paragraph spacing 

Line and paragraph spacing helps you  
to adjust spaces between lines and  
in paragraphs. 

▪ On the Home tab, click the  
Line and Paragraph Spacing  
command, then select the  
desired line spacing. 

Applying Headings 

You can create headings in Microsoft Word documents by applying Word's built-in heading 
styles (such as Heading 1 or Heading 2). After applying these headings you can change different 
attributes i.e color, size, font etc. to apply a heading style. Simply select the text you want to 
format and click on desired heading style located on Style group on Home Tab. 

Justify 
Left Center 

Right 
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Self-Assessment 

After completing this learning session, evaluate your own Microsoft Word proficiency.  

ICT Skills Yes No 

I am able to open Microsoft Word using various 
methods. 

  

 
 

Hands on Practice 

Apply the following text formatting on the given text.   

HRMS: The government of Punjab continuously seeks 

innovative solutions that can help to improve school 

education department by developing e-Transfer system for 

public school teachers across Punjab. 

Set Text size 12. 

Font color Green. 

Make “government of Punjab” bold. 

Text center aligned. 

Make HRMS as heading. 
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I understand the interface of Microsoft Word 
and identify different tabs. 

  

I am proficient in inserting text into a document.   

I can select and replace text.   

I am able to apply Bold, Italic, Underline text.   

I can change Font size.   

I am proficient in applying alignments.   

I can apply bullets and numbering.   

I am able to adjust line & paragraph spacing.   

I can apply headings to a Word document.   
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Upon completing this session, participants will be able to 

proficiently demonstrate the following Microsoft Word skills 

 

▪ Saving a document: 

o Different ways of saving a document. 

o Difference between Save & Save As. 

o Saving file to a specific location. 

 

▪ Opening a Document: 

o Use of Open in Backstage view. 

o Open an already saved document.    

 

▪ Control Buttons: 

o Understand the use of control buttons. 

o Minimize, Restore down/Maximize, Close 

 

 

   Learning Objectives: 

  

SESSION-2 File Management    90 Minutes 
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It is important to Save your document, so you may able to use it again in future.  

Steps to save your document 

▪ Click FILE > Save 

▪ Save As dialog Box appears. 
▪ Select the location where you want to save the document using the drop-down 

menu. 
▪ Enter a name for the document. 
▪ Click the Save Button. 

 
 
 

 

 

 

 

 

 

 

Difference between Save and Save As 

The key difference between Save and Save As is that Save allows 
you to update a previously saved file with new content, whereas 
Save As allows you to save a new file or an existing file to a new 
place with the same or different name.  

 Opening a Word Document 

You can open already saved document using Open command. 

▪ Go to File 

▪ Then click Open 

▪ Select the desired file to open. 

Control Buttons 

▪ Minimize 

▪ Restore down/Maximize 

▪ Close 

SESSION-2 File Management       90 Minutes 

Extra Bit…! 

 Key Board Shortcuts 
COPY= Ctrl + C 
CUT= Ctrl +X 
Paste= Ctrl +V 
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There are three control buttons located on the top right side of the office window. 

Minimize Button:  When you left click on this button the window hides itself on the taskbar; 
which by default is located at the bottom of the screen. 

Restore Down: This button reduces the size of the Word window. When you click the Restore 
Down button again it turns into the Maximize button. The Maximize button fills your screen with 
the Word window. 

Close Button: Close button is used to close the word document. 

Printing a Document  

Once you've created your document, you may want to print it to view and share your 
work offline. 

▪ Select the File tab. Backstage view will appear. 
▪ Select Print. The Print pane will appear. 
▪ Select the desired printer. 
▪ After entering the desired number of 

copies click Print. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

Hands on Practice 

Open a Blank document in MS Word and type “Quaid-e-

Azam Academy for Educational Development” and 

perform following actions. 

Save the file. 

Save As file with another name. 

Print the file. 

Open any already saved file using Open 

command. 
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Upon completing this session, participants will be able to 
proficiently demonstrate the following Microsoft Word skills 

 

● Add Tables: 

o Explain the purpose and importance of tables. 

o Create tables to organize data and information. 

o Customize table properties, including the number of 

rows and columns. 

 

● Insert Pictures: 

o Insert images into a document.    

 

 

 

Self-Assessment 

After completing this learning session evaluate your own Microsoft Word proficiency. 

ICT Skills Yes No 

I am able to save document.   

I can save the file with another name using Save 
As after changes. 

  

I am able to understand the difference between 
Save and Save As. 

  

I am proficient in printing a document.   

I can effectively use control buttons (Minimize, 
restore down/maximize, close) 

  

 

 

 

 

 

 

 

 

Learning Objectives: 

 

     

SESSION-3 Insert Tab                90 Minutes 
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Microsoft Word provides you the facility to insert tables, pictures, clip arts, shapes, charts, 
headers & footers etc. in a document.  

Adding Tables  

Tables can be used to organize any type of content, whether 
you're working with text or numerical data. In Word, you can 
quickly insert a blank table or convert existing text to a table. 

To insert a blank table: 

▪ Place the insertion point/curser where you want the 
table to appear. 

▪ Navigate to the Insert tab, then click 
the Table command and select the number 
of columns and rows you want from drop down 
menu. 

▪ Click the grid to confirm your selection, and a table 
will appear. 

▪ To enter text, place the insertion point in any cell, then 
begin typing the text. 

 
 

 

 

Pictures 

Adding pictures to your document can be a great way to illustrate important information and 
add decorative accents to existing text. 

Insert a picture from a file/computer/mobile: 

▪ Place the insertion point where you want the 
image to appear.  

▪ Select the Insert tab on the Ribbon, and then click 
the Pictures command. The Insert Picture dialog 
box will appear.  

▪ Select the folder to insert desired picture.  

 

SESSION-3 Insert Tab                 90 Minutes 
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Text Wrapping 

When you insert a picture from a file, you may notice that it's 
difficult to move it exactly where you want. This is because 
the text wrapping for the image is set to In Line with Text. 
You'll need to change the text wrapping setting if you want to 
move the image freely. 

Different other options for wrap text available as show in 
given image. 

 

Pictures Formatting 

There are many ways to format pictures in Word. For 
instance, you can change:      

● The size or shape of an image to better suit your 
document.  

● You can also enhance its appearance using Word's image adjustment tools. 

To crop an image 

Select the image you want to crop. The Format tab will appear. 

● From the Format tab, click the Crop command. 
● Cropping handles will appear on the sides and corners of the image.  
●  Adjust the size and to confirm, click the Crop command again. The 

image will be cropped. 

 

 

 

 

Making image 
adjustments 

With Word's image adjustment tools, you can easily change properties like 

● Color 
● Contrast, 
● Saturation  
● Tone 

Word also offers built-in picture styles, which can be used to add a frame, drop shadow, and 
other predefined effects. 

Corrections 

This option helps to adjust: 
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▪ sharpness or softness 

▪ brightness and contrast 

 

 

Color 

This option helps to adjust: 

▪ Image saturation 

▪ Tone  
▪ Coloring (Recolor)  

 

 

Picture Styles group: 

This group contains 
different predefined styles that 
make image formatting even 
easier. Picture styles are 
designed to frame your image 
without changing its basic 
settings or effects. 

 

 

Compressing pictures: 

If you plan to email a document that contains pictures, you'll need to monitor its file size. Large, 
high-resolution images can cause your document to become very large, which may make it 
difficult to attach to an email. In such case Compress Picture is best option you can compress 
your pictures to reduce overall size of document. 

 

 

 

 

 

 

 

 

 

 

  

Hands on Practice 

Create a new blank document and add a table of 3 x 3 as: 

DATA OF OUT OF SCHOOL CHILDREN 

● Set Text size 12 for heading and text size 11 for other fields. 



Beginners ICT Guide for Educators and School Leaders  

Quaid-e Azam Academy for Educational Development, Punjab 28 

 

 

 

 

 

 

 

Self-Assessment 

After completing this learning session, evaluate your own Microsoft Word proficiency. 

 

ICT Skills-Microsoft Word Yes No 

I am able to insert tables in a document with 
text. 

  

I can apply different formatting on text within 
the table. 

  

I am able to insert image from 
computer/mobile. 

  

I can adjust picture color, tone and brightness 
etc. 

  

I can compress picture when needed.   
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Upon completing this session, participants will be able to 

proficiently demonstrate the following Microsoft Word skills 

 

o Headers and Footers: 

▪ Explain the uses of headers & footers in a document. 

▪ Understand how to add header & footer in a document. 

 

o Page Number: 

▪ Add page number to any document. 

 

o Text Boxes: 

▪ Understand the use and importance of text boxes. 

▪ Add text boxes to any image of the document. 

▪ Apply different formatting on inserted text box. 

 

o WordArt: 

▪ Understand the effective use of WordArt. 

▪ Add WordArt in any document. 

 

 

 

 

Learning Objectives: 

 

 

  

SESSION-4 Insert Tab      90 Minutes 
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Header & Footers 

The header is a section of the document that appears in the top margin, while the footer is a 
section of the document that appears in the bottom margin. 

Headers and footers generally contain additional information such as page 
numbers, dates, an author's name or school name. Text entered in headers & footers will appear 
on each page of the document. 

Steps to add Header 

▪ Double click on the top 
of your document 
header will be added.  
OR 

▪ You can also add it from Header & Footer group located on Insert tab. 

Steps to add Footer 

▪ Double click on the bottom of your document header 
will be added. 
OR 

▪ You can also add it from Header & Footer group 
located on Insert tab. 

 

 

Text Boxes 

Text boxes can be useful for drawing attention to specific text. They can also be helpful when 
you need to move text around in your document. 

Steps to add text boxes: 

▪ Select the Insert tab, and then click the Text Box command in the Text group. 
▪ A drop-down menu will appear. Select Draw Text Box. 
▪ Click and drag anywhere on the document to create the text box. 
▪ Now you can add text whatever you want. 

 
 
 
 
 

SESSION-4 Insert Tab                  90 Minutes 

 

Extra Bit…! 

 You can add page 
number from Header & 
Footer group located on 
insert tab.                        
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To move a 
Text Box 

▪ Click the text box you want to move. 
▪ Hover the mouse over one of the edges of the text box. The mouse will change 

into a cross with arrows. 
▪ Click and drag the text box to the desired location. 

To change the shape style 

Choosing a shape style allows you to apply preset colors 
and effects to quickly change the appearance of your text 
box. 

▪ Select the text box you want to change. 
▪ On the Format tab, click the More drop-

down arrow in the Shape Styles group. 
▪ Select the style you want to use from drop 

down menu. 

 

 

 

 

WordArt in MS Word 
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Upon completing this session, participants will be able to 

proficiently demonstrate the following Microsoft Word skills 

 

WordArt is designed to allow you make your text more attractive with special effects. 

Steps to insert WordArt 

▪ Place the cursor where you want to 
insert WordArt 

▪ Select the Insert tab 

▪ In Text group click the 'WordArt' button 

▪ WordArt menu appears; 

 

 

 

 

 

 

 

 

 

Self-Assessment 
Use these self-assessment statements to evaluate your own Microsoft Word proficiency. 

ICT Skills Yes No 

I can add header & footer in a document.   

I can add page number.   

I am able to insert text box in a document.   

I can adjust text box and apply different formatting 
on text box. 

  

I can insert WordArt in a document.   

 

 

 

Learning Objectives: 

 

ICT How it looks 

  

Hands on Practice 

Create a new blank document OR open any already saved 

document. Apply following actions on the document: 

Add header and footer  

Write “ICT Skills” in Header 

Write “QAED Punjab, Lahore” in footer. 

Add page number. 

Add a text box & apply different formatting on it. 

Insert a WordArt. 

 

SESSION-5 Layout Tab                      90 Minutes 
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Page Layout 

Word offers a variety of page layout and formatting options that affect how content appears on 
the page. You can customize the page orientation, page size, and page margins depending on 
how you want your document to appear. 

Page Margins 

SESSION-5 Layout Tab                90 Minutes 
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A margin is the space between the text and the edge of your document. By default, a 
new document's margins are set to Normal, which means it has a one-inch space between the 
text and each edge. 

 

 

 

 Depending on your needs, Word allows you to change your 
document's margin  size. 

To set Margins: 

▪ Select the Layout tab, and then click the Margins. 
▪ A drop down menu will appear, select your desired margin. 

Word also allows you to customize the size of your margins. 

Page 

Word offers two page orientation options:  

Landscape and Portrait. Landscape means the page is 
oriented horizontally. Portrait means the page is 
oriented vertically. 

 

 

 

  

Extra Bit…! 

 
Your Salary slip is in Portrait 
while our Staff Statement is 
in Landscape.                         

 



Beginners ICT Guide for Educators and School Leaders  

Quaid-e Azam Academy for Educational Development, Punjab 35 

Steps to change orientation of page 

▪ Select the Layout tab. 
▪ Click the Orientation command in the Page Setup group. 
▪ A drop-down menu will appear. Click either Portrait or Landscape to change the page 

orientation. 
 

Page size 

By default, the page size of a new document is 8.5 inches by 11 inches. You may change it 
according to your need. 

 

Steps to change size of a page: 

▪ Select the Layout tab, then click 
the Size command. 

▪ A drop-down menu will appear. The current page size is highlighted. Click the 
desired predefined page size. 

Adding Columns 

Sometimes the information you include in your document is best displayed in columns. 

We use columns in different scenarios like  

▪  Newspaper articles 

▪  Newsletters 

▪  Flyers 

 Word also allows you to adjust your columns by 
adding column breaks. 
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To add columns to a document 

▪ Select the Layout tab, then click the Columns command. A drop-down menu will 
appear. 

▪ Select the number of columns you want to create. 
▪ The selected text or document will format into columns. 

 

 

 

 

 

 

 

 

Self-Assessment 

Use these self-assessment statements to evaluate your own Microsoft PowerPoint 
proficiency after completing the learning session. 

ICT Skills Yes No 

I can set margins in a document.   

I am able to differentiate page orientation.   

I can adjust page size.    

I can add columns in a document.   

I am able to print a document.   

 

 

 

  

Hands on Practice 

Create a new blank document OR open any already saved 

document. Apply following actions on the document: 

● Set Page Margins to Narrow. 

● Set Page Size to Legal. 

● Adjust Orientation Landscape. 

● Split the page into two columns. 

 



Beginners ICT Guide for Educators and School Leaders  

Quaid-e Azam Academy for Educational Development, Punjab 37 

 

 

 

  

 

Microsoft PowerPoint 
 

 

 
        Learning Objectives: 

 
Upon completing this session, participants will be able to proficiently 
demonstrate the following PowerPoint skills: 

 

● Opening Microsoft PowerPoint: 
Open Microsoft PowerPoint software on their computers. 
Learn multiple methods to launch PowerPoint, including using 
the Start menu, taskbar, or a shortcut icon. 

SESSION- 6 Introduction to PowerPoint           90 Minutes 
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● Navigating the PowerPoint Interface: 
Accurately identify and label the key components of the 
PowerPoint interface screen. 
Recognize and understand the functions of the Ribbon, Tabs, 
Slides Pane, and the Slide Sorter View. 

● Creating Text-Based Content: 
Demonstrate the ability to create text-based content on 
PowerPoint slides. 
Learn how to insert text into placeholders and text boxes. 
Achieve proficiency in basic text formatting options, including 
font size, style, and alignment. 

● Adding New Slides: 
Successfully add new slides to a PowerPoint presentation. 
Understand how to choose different slide layouts based on 
their content requirements. 

● Inserting Images and shapes: 
Effectively insert images, shapes and word Art into PowerPoint 
slides,  
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Introduction to PowerPoint 

Microsoft PowerPoint is a widely used computer program developed by Microsoft as part of the 
Microsoft Office suite. It is primarily designed for creating and delivering multimedia 
presentations. PowerPoint allows users to create slideshows that can incorporate text, images, 
graphics, charts, videos, and audio elements. 

How I will use Microsoft PowerPoint as teacher or School leader? 

As Teachers: Microsoft PowerPoint can be a valuable tool for teachers and educators in various 
ways to enhance their teaching and engage students effectively through colourful content 
slides. It can also be used for online teaching. 

As Head Teachers: Head Teachers/Principals can use Microsoft PowerPoint for staff meetings, 
school-based professional development (CPD) training sessions with staff, and to conduct 
awareness sessions for students. School leaders can also use PowerPoint to communicate the 
school improvement plan and highlighting improvements regarding organizational goals to 
official visitors  

How to Launch Microsoft PowerPoint and Introduction of its first screen? 

● Click on the Start Button: In the bottom-left corner of your screen 

● Search for "PowerPoint": In the search bar, type "PowerPoint" and press Enter 

 
Introduction to PowerPoint Interface (first screen) 

Ribbon A toolbar at the top of the screen that provides access to most of the 
PowerPoint functions and features 

Slides The main area where you create your presentations. 
Outline view A view that displays a text outline of your presentation. 

Slide sorter view 
A view that displays thumbnails of your slides, allowing you to easily 
rearrange them. 
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Notes pane A section below each slide where you can add notes or comments for 
yourself or the presenter. 

Task pane: 
A floating window that provides access to various PowerPoint tasks and 
features. 

View buttons Allows you to switch between different views of your presentation 
(Normal, Slide Sorter) 

Zoom slider  Allows you to adjust the magnification of your slides on the screen. 
 
How to create a presentation? 

1. Open PowerPoint. 
2. In the left pane, select New. 
3. Select an option: 

● To create a presentation 
from scratch, select Blank 
Presentation. 

● To use a prepared design, 
select one of the 
templates. 

 

In Microsoft PowerPoint, we can 
use the text formatting commands 
and shortcut keys in the same way we have learned in Microsoft Word. 
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How to Adding text on slide 

To write text on the slide click on the box on slide showing text “click to add title”  

 

 

 

 

 

 

 

 

 

How to change Font and text size on slide? 

Select the text, and then select one or more options from the Font section of the Home tab, 
such as Font, Increase Font Size, Decrease Font Size, Bold, Italic, Underline, etc. 

How to add a new slide? 

In the Home tab, in the Slides section, select New Slide. 

How to add a slide layout? 

In the Slides section, select Layout, and then  

select the layout you want from the menu. 

 

 

 

What is slide Layout? 

Slide layout refers to the predefined arrangement and formatting of content elements on a slide. 
It determines where text, images, placeholders, and other objects should appear on the slide. 

 

 
To Insert New Slide 
Ctrl+ M  

Shortcut Key 
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Microsoft PowerPoint offers a variety of slide layouts that we can use according to the 
content's needs for our slides. 

 

 

 

 

 

 

 

 

 

 

How Add a picture, shape, and more objects on your slides? 

Go to the Insert tab. 

To add a picture: 

In the Images section, select Pictures. 

In the Insert Picture From menu, 
select the source you want. 

Browse for the picture you want, 
select it, and then select Insert. 

 

Note for trainer: Once the participants have learned how to insert a picture on a slide, then guide 
them on how to move and resize the picture. Afterward, guide them about the other tools available on 
the Insert tab, such as shapes and WordArt, etc. 

 

 

   

Hands on Practice 

Create a PowerPoint Presentation with five slides on the 

any topic you have learnt in your promotion link training. 
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Self-Assessment 

Use these self-assessment statements to evaluate your own Microsoft PowerPoint 
proficiency after completing the learning session. 

 

ICT Skills –PowerPoint Yes No 

I am able to open Microsoft PowerPoint using various methods.   

I am able to label and identify the key components of the 
PowerPoint interface.   

I understand the functions of the Ribbon, Tabs, Slides Pane, and 
the Slide Sorter View.   

I am proficient in inserting text into placeholders and text boxes.   

I can apply basic text formatting options, including font size, 
style, and alignment.   

I am capable of adding new slides to a PowerPoint presentation.   

I understand how to select appropriate slide layouts based on 
content needs.   

I can effectively insert images into PowerPoint slides   

 

 

 

 
       Learning Objectives: 

 
 
  

Upon completing this session, participants will be able to proficiently 
demonstrate the following PowerPoint skills 
 
● Design: 
o Apply effective slide design to create visually appealing slides. 

SESSION- 7 Applying designs, Slide Transition & Animation    90 Minutes 



Beginners ICT Guide for Educators and School Leaders  

Quaid-e Azam Academy for Educational Development, Punjab 44 

o Become proficient in choosing suitable colors, fonts, and 
backgrounds for their presentations. 

● Transition: 
o Capable of applying and customizing transition effects effectively in 

their PowerPoint presentations. 
o Control the timing and duration of transitions with precision. 

● Animation: 
o Become skilled at applying entrance, exit, emphasis, and motion 

path animations to enhance slide content. 
o Become proficient in adjusting animation settings, including 

direction, speed, and triggers. 
● Slide Show: 
o Confidently start and navigate PowerPoint slide shows. 

 

 

 

 

 

 

 

 

What is slide design in PowerPoint 
 
In Microsoft PowerPoint, the "Design" tab is one of the primary tabs located on the 
PowerPoint ribbon, and it is a powerful tool for customizing the overall design and 
appearance of your presentation. The Design tab offers various features and options to 
help you create visually appealing and cohesive slides. Here are some of the key uses of 
the Design tab: 

How to apply design on slide?  

 

1. Select the Design tab. 
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2. In Themes section. choose any design of your choice 

 

Once you've applied a theme, you can also select a variant for that theme from 
the Variants group. Variants use different theme colors while preserving a theme's overall look. 

 

 

What is slide Transition? 

In Microsoft PowerPoint, a transition refers to a visual or animation effect that is applied to 
individual slides as they change from one to the next during a slideshow presentation.  
Transitions are used to add visual interest, create a smooth flow between slides, and make the 
presentation more engaging. They are a way to control how one slide exits the screen and how 
the next one enters. 

How to Apply Slide transitions? 

Select the slide on which you want to add a transition 

 
On the Transitions tab, select the effect you want to apply on your slide. There are three 
categories of unique transitions to choose from, subtle, exciting, dynamic content 
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To apply same transition to all the slides, select Apply to All 

 

To remove the transition effects from slide, select None from the ribbon 

To preview the transition effects on slide, click on preview  

 

 

 

 

Animation effects on text and objects 

In Microsoft PowerPoint, animation refers to the process of adding movement or dynamic effects 
to individual elements on a slide, such as text, images, shapes, and other objects. Animations are 
used to make a presentation more visually engaging, illustrate concepts, and emphasize key 
points. They can bring elements onto the slide, make them exit, emphasize them, or create more 
complex movements and transformations. 

Types of animation effects 
There are several animation effects, you can select according to your choice, they are 
organized into four types. 
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Entrance: This group of animation effects controls how the object enters the slide.  
 
 
 
 
 
 
 
 
 

Emphasis: 
These animations occur while the object is on the slide, often triggered by a mouse click 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Exit: This 

group of 
animation controls how the object exits the slide. 
 
 
 
 
 
 
 
 
 

Motion 
& Path: 
these are 
similar to Emphasis effects, except the object moves within the slide along a predetermined 
path, like a circle. 
 
 
 
 
 
 
How to apply animation effects?  

To animate text or objects on a slide: Select the text or object you want to animate. 
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On the Animations tab, click on the drop-down menu to see all four type of animation effects. 

 Then select the animation you want to apply from the drop-down box. 

 

The effect will apply to the object on the slide. 

 

Change on the slide after animation: 
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After the animation, the object will have a small number next to it to show that it has 
an animation. In the Slide pane, a star symbol also will appear next to the slide. 

To remove the transition effects  

Select the small number located next to the animated object.  
Then Press the Delete key from keyboard. The animation will be deleted. 
 
Slide show of the presentation: 

In Microsoft PowerPoint, a slide show is like a digital, interactive storybook made up of individual 
pages called 'slides.' These slides appear on the screen one after the other in a specific order. A 
slide show is typically used for presenting information, ideas, or content in a visual and sequential 
manner.  

How to run slide show in PowerPoint? 

Select "Slide Show" Tab: Go to the "Slide Show" tab on the PowerPoint ribbon, located 
at the top of the application window. 
Start the Slideshow: In the "Start Slide Show" group, you have several options: 
From Beginning: Click "From Beginning" to start the slideshow from the first slide. 
From Current Slide: If you want to start the slideshow from the slide you're currently 
on, click "From Current Slide." 
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Self-Assessment 

After completing this session, use these self-assessment statements to evaluate your 
own Microsoft PowerPoint proficiency. 

 

ICT Skills-PowerPoint Yes No 

I can apply effective slide design to create visually appealing slides in 
my presentations.   

I consistently choose appropriate colors, fonts, and backgrounds 
that enhance the overall design of my slides.   

I am proficient in applying and customizing transition effects to 
create a seamless flow between slides.   

I can confidently control the timing and duration of transitions to 
match the content and pace of my presentations. 

  

I am skilled at using entrance, exit, emphasis, and motion path 
animations to enhance the visual appeal of my slides. 

  

I am able to start and navigate PowerPoint slide shows with ease.   

I effectively use interactive elements like hyperlinks and action 
buttons to engage and guide the audience during presentations. 

  

 

 

 

 

  

Hands on Practice:  

Create a PowerPoint Presentation and apply design, slide 

transition, animation on the slides and run slide show from 

beginning. 
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Microsoft Excel  
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Session Learning Objectives 

 

After completion of this session, the participants will be able to 
 

● Opening Microsoft Excel and Layout Introduction: 

o Launch MS Excel using different methods including Using Shortcut, 

Start Menu, etc.  

o Get familiarized with MS Excel Window elements. 

 

● Saving, Opening and Converting the Excel File 

o Launch a new MS Excel File, save it at their desired location 

o Convert Excel into a PDF File. 

 

● The concept of Cells, Rows, Columns, etc... 

o Know what is cell, Rows and Columns in MS Excel and how this 

work.  

o Learn how to enter and manage data into a sheet. 

 

● Difference between Excel Workbook and Sheet 

o Learn about the difference between Excel workbook and sheet. 

o Learn how to insert multiple sheets in an existing workbook using 

the plus sign. 

 
 

 

 

 

 

Microsoft Excel 

Microsoft Excel is powerful spreadsheet software widely used for data analysis, calculations, 
and organization. 

Session 8 – Introduction to MS Excel          90 Minutes 
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It allows users to create, edit, and manipulate data in a grid format of rows and 
columns (and each intersection is called cell). Excel is known for its functions and formulas, 
making it ideal for tasks like budgeting, data visualization, and financial analysis.  

 

Layout of MS Excel Window 

 

 

 

Upon opening MS Excel, we see a window like the above one that has different parts for 

different purposes and the details of the parts is given below. 

● Title Bar: Displays the document name and provides window control options. 

● Formula Bar: Allows viewing and editing of cell contents and formulas. 

● Ribbon: Contains tabs with commands for various Excel functions. 

● Worksheet Area: The main grid for data input, calculations, and charts. 

● Column Headers and Row Numbers: Help reference specific cells in the grid. 

● Sheet Tabs: Enable switching between different worksheets in the workbook. 

● Status Bar: Provides information about document status and options like zoom. 

● Quick Access Toolbar: It gives easy access to frequently used commands for improved 

productivity. 

● Cells: The intersection of Column and row is called cell which is a basic unit of an excel 

sheet 
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● Name Box: This contains the names of every cell comprising the column name 

and row number 

● Zoom Slider: We can zoom in or zoom out the window to fit the contents on the screen 

The use of MS Excel in Educational Institutes 

The use of MS Excel in schools is widespread for tasks such as managing student data, creating 
result cards, analyzing educational data, and teaching students valuable spreadsheet skills, which 
are essential in various academic subjects and future careers. Few more usage of Excel are given 
below 

● Grade book and Attendance Tracking 

● Lesson Planning 

● Data Analysis 

● Budgeting and Expense Tracking 

● Graphs and Charts for Visual Learning 

● Student Records Management 
● Timetables and Scheduling 

● Interactive Learning Activities 

● Financial Literacy 

● Data Visualization Projects: 

Difference between Excel Workbook and Sheet 

An Excel workbook is like a file containing multiple Excel sheets (also called worksheets), 
Workbooks can be thought of as files, while sheets are the pages within those files. 
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File Handling in MS Excel 
 

Create New Workbook 

Whenever, MS Excel program opens, it automatically creates a worksheet with the name 

sheet1. However, you can create new workbook by navigating to File >>New option or you can 

create it using keyboard shortcut key Ctrl + N. 

 

Open File 

In MS Excel, the "Open" option 

allows you to open an existing 

Excel workbook or spreadsheet file 

from your computer or a 

connected storage device. This 

feature is used to access and edit 

previously created Excel files or 

import data from external sources 

into a new or existing Excel file. You 

can open a file by navigating File >> Open or the shortcut key Ctrl + O can be used for the same 

purpose. 

Whenever you want to save your workbook on your computer or on cloud drive (Google or One 

Drive), you have to save it through File > Save name it from the Save dialog box and click save 

button. Save option is also used to save any unsaved changes made to the currently open 

workbook and by clicking Save will update the existing file with the changes. It doesn’t prompt 

you to a new file name or location. 

Save As file 

"Save As" in Excel is an option that allows you to save the current Excel workbook with a new 

name, location or file format it also enables us to convert a different file format Including PDF, 
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CSV or previous Excel versions. It is actually used to produce multiple copies of a 

workbook which is called reprographics. 

Save or convert MS Excel Sheet to PDF 

You can use the MS Excel to save or convert your files to PDFs, so that you can share them or 
print them using commercial printers. 

● Click File  Save As. 
● In the File Name box, enter a name for the file. 
● In the Save as type list, click on the required format like PDF (*.pdf). 
● To open in the selected format after saving, select the Open file after publishing check 

box. 
● Click Save. 

 

 

 

 

The concept of worksheet  

An Excel worksheet is a collection of rows and columns and the intersection of Column and row 

is known as Cell. Cells are used to record data and each cell is uniquely identified by its address. 

Columns are usually labeled with letters (A,B,C,… ) while rows with numbers (1,2,3…). 

Note: Number of sheets in an Excel Workbook can 

be increased or decreased as per requirement. 

  

Hands on Practice 

Create an Excel Workbook, enter some data and 

save it as pdf with your own name at Desktop. 

Extra Bit…! 

 
We can Add up to 

255 sheets to an 

Excel Workbook. 
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Adding a New Sheet to a Workbook 

To add a new sheet to your existing workbook, 

open your workbook and click on “+” button in 

the bottom area as shown in the image. 

 

 

Entering data in MS Excel 

To manually enter data: 

● Select an empty cell, such as A1, and 
then type text or a number. 

● Press Enter or Tab to move to another 
cell. 

To fill data in a series: 

● Enter the beginning of the series in two cells: such as Jan and Feb; or 2014 and 2015. 

● Select the two cells containing the series, and then drag the fill handle across or down the 

cells. 

 

 

 

 

  

Hands on Practice 

Create two sheets in MS Excel and generate a series of 

data e.g. Roll Number of students and in another sheet, 

use fill handle to fill the text. 
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Self-Assessment 

Use these self-assessment statements to evaluate your own Microsoft Excel 
proficiency after completing the learning session. 

Skill Yes No 

Do I know what is Excel Workbook and sheet?   

Do I know how to Save and Save as a file?   

Do I know how to Open an existing excel workbook?   

Do I know how to convert an existing workbook into a PDF file?   

Do I know how to enter data into excel?   

Do I know how to create a series-based data into MS Excel?   

 

 

 

 

 

 

 

 

 

 

Session Learning Objectives 

 

Session 9 – Charts and Data Sorting        90 Minutes  
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After completion of this session, the participants will be able to 

 
● Rows and Columns in Excel 

o Learn about the Rows and Columns in excel 

o Adjust Rows and Columns in the sheet  

 

● Charts in Excel 

o Know what are charts and its different types in Microsoft Excel 

o Insert charts  

 

● Sorting  

o Know what is sorting in Microsoft Excel  

o Sort the data in the sheet 

 

● Merge Cells, Wrap text and cell alignments  

o Apply cell merge cells , and cell alignments  

o Wrap text in a cell 

 

 

 

 

 
Rows in Excel 

A row in MS Excel is a horizontal line of 

cells that runs from left to right across the 

spreadsheet grid. Rows are identified by 

numbers (1, 2, 3…) and are used to organize 

and display data horizontally. 

 

Column in Excel 

In MS Excel, a column is a vertical series of cells that runs from top to bottom within the 

spreadsheet. Columns are labeled with letters (A, B, C…) and are used to organize and display 

data vertically. 
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The concept of a “Cell” in Excel Sheet 

In MS Excel, a cell is the basic unit of the 

spreadsheet grid where you can enter and 

manipulate data. It is the intersection of a row 

and a column and is identified by a unique 

combination of a column letter and a row 

number (e.g., A1, B2). 

Cells can contain various types of data, 

including numbers, text, formulas, and 

functions, making them the building blocks 

for creating worksheets, performing 

calculations, and organizing information in 

spreadsheets. 

Charts in MS Excel 

A chart in MS Excel is a visual representation of data. It is a powerful tool that can help you to 

understand and communicate your data more effectively. Charts can be used to compare 

different data sets, show trends over time, and highlight important relationships in your data. 

There are different types of charts in Excel and 

each have its own features. Some of them are 

discussed below. 

 

 

 

Some most used chart types 

Bar Charts: A bar graph or bar chart is a graph that displays different categories of data with 
rectangular bars, where the lengths of the bars are proportional to the size of the data category 
they represent. Bar graphs can be plotted vertically or horizontally. 
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Column charts: Column charts are 
good for comparing different data sets. Each 
data set is represented by a vertical column, 
and the height of the column represents the 
value of the data point. 

Line charts: Line charts are good for 
showing trends over time. Each data point is 
represented by a circle or other marker, and 
the data points are connected by lines. 

Pie charts: Pie charts are good for showing 
the relationship between different parts of a whole. Each data point is represented by a slice of 
the pie, and the size of the slice represents the percentage of the whole. 

How to Insert Chart in Microsoft Excel  

1. Select the data you want to include in your chart. Make sure to include your column 
names if you want them to be in the chart. 

2. Click the Insert tab. 
3. Select a chart type in the Charts group. 

 

The chart appears in the worksheet and the Chart Tools appear on the Ribbon. The Chart Tools 
include three new tabs—Design, Layout and Format—that help you modify and format the chart. 
Explore these tabs and make changes to your charts  

 

Create a Recommended Chart 
Many times, it’s hard to tell what type of chart will best illustrate your data. To help make your 
decision easier, Excel offers Recommended Charts. This tool looks at the data you have 
selected and suggests a few charts that will represent it well. 

1. Select the data you want to include in your chart. 
2. Click the Insert tab. 
3. Click Recommended Charts 
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Sorting in Excel 

Sorting in MS Excel is the process of arranging data in a specific order based on one or 
more criteria. It's a useful feature for organizing and analyzing data within a spreadsheet. 
Excel provides both ascending (from smallest to largest) and descending (from largest 
to smallest) sorting options. Here's how sorting works in Excel: 

1. Select a cell in the column to 
which you want to sort. 

2. Click the Data tab, then 
select the Sort command. 

3. Click on the Sort Ascending 
Icon, if you want to sort data 
in ascending order. 

Or 

Click on the Sort Descending Icon, if 
you want to sort data in descending 
order 

4. A message box will pop up 
for expand selection option, 
click yes. 

5. The worksheet will be sorted according to the selected order. 

Merge and center 
You can merge cells together to create a larger cell without changing the row or column size. 

1. Select the cells you want to merge together. 

Hands on Practice 

Create a tabulated data with a minimum two 

columns and plot a bar chart from that data. 
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2. Click the Merge list arrow. 
3. Select a merge option. 

 

 

Wrap Text in a Cell 
You can use the text wrap option to make all cell contents visible. If you wrap text in a cell, it 
increases the row height to display everything within the cell. 

1. Select the cell(s). and click on home tab 
2. Click the Wrap Text button. 

 

Text Alignment in cells 

By default, the contents of a cell appear at the bottom of the cell, with numbers aligned to the 
right and text aligned to the left. If this doesn’t work for your spreadsheet, change it with 
Excel's alignment options. 
Change Cell Alignment 

1. Select the cell(s) you want to align. 
2. To vertically align cells, click the vertical alignment button you want. 
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3. To horizontally align cells, click the horizontal alignment button you want. 

 

 

 

 

 

Self-Assessment 

Use these self-assessment statements to evaluate your own Microsoft Excel 
proficiency after completing the learning session. 

Skill Yes No 

I can create charts in Ms Excel   

I can choose the most suitable chart type to represent data effectively.   

I understand when and how to merge cells in Excel   

I know how to use the "Wrap Text" feature to make long text entries 
visible within a cell. 

  

I can sort data in Excel in both ascending and descending order.   

I am proficient in aligning text and numbers within cells   

Hands on Practice 

Write text in cells and apply the cell alignment, 

merge cells and wrap text options  
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Session Learning Objectives 

 

After completion of this session, the participants will be able to 
 

● Excel Formula 

o Know what Excel formula is and what is Function? 

o Learn how to use formulas and function in an excel sheet 

o Manipulate data according to the needs. 

 

● Use of Most widely used Excel Formulas 

o Learn different formulas including Sum, Average, Percentage, etc. 

 

● Conditional output with IF Function 

o Learn how to use IF function to achieve the conditional output 

based on criteria given in IF function.  

o Learn how to use the IF function for school based activities. 

 

● Paste Special Command 

o Learn about the various uses of Paste Special command in Excel.  

  

SESSION 10 – Use of Formula          90 Minutes 
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Excel Formula 

A formula in Excel is an expression that performs calculations on values in a range of cells. 

Formulas can be used to perform simple calculations, such as addition and subtraction, or more 

complex calculations, such as finding the average or calculating percentages. 

Formulas can also be used to 

perform logical operations, such 

as testing if a value is greater than 

or less than another value. 

Use of common Excel 
Formulas/Functions 

Formulas and function make our 

life easier and can provide 

fantastic results in terms of calculations and analysis. We can perform many formulas and 

functions in a single sheet to achieve the desired results. 

A few common functions and formulas are given below 

SUM Function 

A highly used function in Excel is SUM. The SUM function in Excel is a mathematical function 
used to add up a range of numbers. It calculates the sum of all the values within a specified range 
of cells.  

For example: 

 =SUM(A2:A10) Adds the values in cells from A2 to A10. 

 =SUM(A2:A10, C2:C10) Adds the values in cells A2:10, as well as cells C2:C10. 

SUM with individual Cell References vs. Ranges 

Using a function like: 

 =SUM(A1,A2,A3,B1,B2,B3) 

Is equally error prone when inserting or deleting rows within the referenced range for the same 
reasons.  
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In the above image, you can we have used the sum function to calculate the SUM of the cell 

range C4:F4 in G4 Cell. 

Average Function 

Average is another important function that calculates the arithmetic mean of a set of numbers. It 

is one of the most commonly used functions in Excel, and it can be used to perform a variety of 

tasks, such as calculating the average grade for a class of students, etc. 
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Percentage Formula 

It is another important formula to calculate the percentage of different items e.g. calculating the 
percentage of marks obtained by the students in school. 

The generic method to calculate percentage is =number1/number2*100 like if we want to 
calculate the percentage of obtained marks by the students, this is the syntax 
=obtained_marks/total_marks*100  

 

MIN Function 

The MIN function in MS Excel is a statistical 
function that returns the smallest value in a 
set of numbers. It is one of the most 
commonly used functions in Excel, and it can 
be used to perform a variety of tasks, such as 

● Finding the lowest price for a product 

● Determining the shortest time to 
complete a task 

● Identifying the smallest number in a 
range of cells 

To find out the minimum value within a 
given range of cells 

● Put the control in the cell where you 
want to show the minimum value 

● Write the formula =MIN (range_of_cells) like in the picture =MIN(C4:C8) 
● Press Enter key from keyboard. 

MAX Function 
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The MAX function in MS Excel is a built-in mathematical function used to find the 

largest or maximum value within a range of numbers. It allows you to quickly determine the 

highest value among a set of numbers. 

IF Function 

The IF function in Excel is a logical function that returns one value if a condition is true and 
another value if the condition is false. The IF function is one of the most commonly used functions 
in Excel, and it can be used to perform a variety of tasks, such as: 

● Making decisions based on data 

● Applying different formulas to different data sets 

● Creating conditional statements 

This is an important function that can be used in educational institutes like designing the report 
cards, attendance sheets, staff register, etc.. This command has a variety of usage but we are 
going to use it with only two arguments for the simplicity purpose. 

General syntax for this command is =IF(logical_test, value_if_true, value_if_false) and in our case, 
we will be using this as given below 

=IF(J4>33, "Pass", "Fail") 

 

Paste Special Command 

The Paste Special option in Excel allows you to paste copied data into a worksheet with different 
formatting options. This can be useful for pasting data from other sources, such as websites or 
other Excel worksheets, without losing the original formatting. 

To use the Paste Special option, simply copy the data you want to paste and then select the cell 
where you want to paste it. Next, click on the Paste Special button on the Home tab. This will 
open the Paste Special dialog box. 

In the Paste Special dialog box, you can select from a variety of paste options. Here are 
some of the most common options: 
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● Values: This option will paste the values of the copied data without any 
formatting. 

● Formats: This option will paste the formatting of the copied data without the 
values. 

● Linked: This option will paste a link to the copied data. This means that any 
changes you make to the copied 
data will also be made to the pasted 
data. 

● Picture: This option will paste the 
copied data as a picture. 

● Text: This option will paste the 
copied data as text. 

You can also use the Paste Special dialog 
box to paste formulas, comments, and 
other types of data. 

Here is an example of how to use the Paste 
Special option to paste data from a website 
into Excel: 

1. Copy the data from the website. 

2. Select the cell in Excel where you want to paste the data. 

3. Click on the Paste Special button on the Home tab. 

4. In the Paste Special dialog box, select the Values option. 

5. Click on the OK button. 

The data will be pasted into Excel without any formatting. 
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Self-Assessment 

Use these self-assessment statements to evaluate your own Microsoft Excel 
proficiency after completing the learning session. 

Skills Yes No 

Can I create a sheet and populate data to it?   

Can I create a result sheet in Excel?   

Can I use get conditional results using If function?   

Do I know the usage of Paste special in sheet?   

Do I know how to sort the data?   

Do know how to filter the data?   

 

 

 

 

 

 

Hands on Practice 

Design a result sheet containing different subjects’ marks 

where you will have to calculate SUM of Obtained Marks, 

Average, Percentage and Result (Fail/Pass) 

Session 11 – Internet         90 Minutes 
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Session Learning Objectives 
 

   After completion of this session, the trainees will be able to 
 

● Use the Gmail 

● Create a highest used Google Product, Gmail.  

● Read email, reply email and compose a new email. 

 

● Use Google Drive 

● Know about the Google Drive and the way how to use it.  

● How to sync the files and photos and store the photos in HD 

quality. 

● Google Search 

● Know how to search in using Google search engine. 

 

● ChatGPT 

● Provide natural and contextually relevant responses to user 

queries and engage in meaningful text-based conversations, 

drawing on a wide range of general knowledge and information. 

 

● Google Bard 

● Know conversational AI system that can engage in empathetic and 

helpful conversations with users, understanding and responding to 

their emotional and informational needs in a compassionate 

manner. 
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Gmail 
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Gmail (For Desktop Users) 

Gmail is a free email service from Google. It is one of the most popular email services in the 
world, with over 1.5 billion active users. Gmail is easy to use and offers a variety of features, 
including: 

● Large storage space: Gmail users get 15GB of free storage space for their emails. 

● Powerful search: Gmail's search feature is very powerful and can help you find your 
emails quickly and easily. 

● Spam filtering: Gmail has a built-in spam filter that helps to keep your inbox clean of 
unwanted emails. 

● Mobile app: Gmail has a mobile app that is available for both iOS and Android devices. 

Gmail Account Creation 

To use a Gmail, you will need to have a Google account. If you do not already have a Google 
account, you can create one for free. 

1. Go to the Gmail signup page https://accounts.google.com/SignUp 

2. On signup page, you have different options but you can select “For Myself” 

3. Enter your First Name and Last Name and hit Next Button 

4. Enter your Date of Birth and select Gender and hit Next Button 

5. On this step, Google will suggest the email address or you can use your own 

6. On next step, we add the password 

7. It will ask for a Recovery Email Address (that is optional) but this will be used for 
password recovery later 

8. In the next Step this will ask for Phone number (Optional but recommended). Enter the 
phone number and hit Next button 

9. On the last step, it will ask to review the information 

10. Click "Accept Terms and Create Account". 

 

 

 

https://accounts.google.com/SignUp
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Compose an Email 
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Compose option is used to compose a new email that can be sent to one or many email 
addresses at a time. 

To log in to Gmail, go to the Gmail login page and 
enter your username and password. 

To compose an email, click the "Compose" 
button at the top of the page. 

1. In the "To" field, enter the email address 
of the person you want to send the email 
to. 

2. In the "Subject" field, enter a short 
description of what your email is about. 

3. In the body of the email, type your message. 

4. To attach a file to your email, click the "Attach files" button and select the file you want 
to attach. 

5. When you are finished composing your email, click the "Send" button. 

How to read emails 

When you receive a new email, it will appear in your inbox. To read an email, click on 
it. 

● The email will open in a new 

window. 

● You can then read the email 

and reply to it if you want 

● Click on Reply Button in top 

right corner 

● Write reply message to the 

email 

● Click on Send button 
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Hands on Practice 

Create your new Gmail account, send an email to your co-

participant, read an email and reply to it. 
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Google Drive 
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Google Drive Introduction 

Google Drive is a cloud storage service 

developed by Google. It allows users to 

store files online and access them from 

anywhere with an internet connection. 

Google Drive also offers a suite of 

productivity tools, such as Google Docs, 

Sheets, and Slides, which allow users to 

create and edit documents, spreadsheets, 

and presentations online. 

How to use Google Drive 

To use Google Drive, you will need to create a Google account. Once you have a Google account, 

you can go to drive.google.com to access Google Drive. 

From the Google Drive home page, you can upload files from your computer, create new files 

using the Google productivity tools, or share files with others. 

● To upload files from your computer, click the New 

button and select File upload. Then, select the files 

you want to upload from your computer. 

● To create a new file using the Google productivity 

tools, click the New button and select the type of file 

you want to create. For example, to create a new 

document, select Google Docs. 
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● To share a file with others, 

right-click on the file and select 

Share. Then, enter the email 

addresses of the people you want 

to share the file with. You can also 

choose to give them permission 

to view, comment, or edit the file. 

 
● You can also share the link of file 

with someone, anyone with the 

link can open file, edit, view or 

comment on it. 

How to Search using Google chrome 
You can quickly find what you’re looking for on the Internet 

1. On your computer, open Chrome . 
2. In the address bar at the top, enter the key word of your search.  
3.  Press Enter.  

You can search using voice command or image also  
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Google Photos 
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Google Photos is a cloud-based photo and video storage and sharing service 

developed by Google. It is available for free with unlimited storage for photos and videos backed 

up in High quality (16MP for photos and 1080p for 

videos). 

You can also choose to store your photos and 

videos in Original quality, but this will count 

against your Google Account storage limit 

(15GB for free accounts). 

Google Photos is available on the web, as well as 

on Android and iOS devices. It offers a 

number of benefits, including: 

● Automatic backup and sync: Google 

Photos can automatically back up your 

photos and videos from your devices to 

the cloud. Once your photos and 

videos are backed up, you can access 

them from anywhere on any device. 

● Powerful search: Google Photos has a 

powerful search feature that allows you 

to easily find specific photos and 

videos. You can search by date, location, people, objects, and even text in photos. 

● Smart organization: Google Photos automatically organizes your photos and videos into 

albums based on date, location, and people. You can also create your own albums and 

add photos and videos to them manually. 

● Easy sharing: Google Photos makes it easy to share photos and videos with friends and 

family. You can create shareable albums, send individual photos and videos via email or 

text message, or even share them to social media. 

How to use Google Photos? 

1. To start using Google Photos, download the app on your device or visit the website. 

2. Sign in with your Google account. 
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3. If you want to automatically back up your photos and videos, tap the three lines 

in the top left corner of the app and select "Settings" > "Back up & sync". 

4. Toggle the switch on next to "Back up & sync". 

5. You can also choose to back up only photos or videos, or to back up only when your 

device is connected to Wi-Fi. 

6. Once your photos and videos are backed up, you can start viewing, organizing, and 

sharing them. 
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Google Bard AI 

 

& 

ChatGPT 
ChatGPT and Google Bard are large language models (LLMs) that are trained on a massive dataset 

of text and code. They can generate text, translate languages, write different kinds of creative 

content, and answer your questions in an informative way. 
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ChatGPT is a generative pre-trained transformer model developed by OpenAI. It is a 

powerful tool that can be used for a variety of tasks, including: 

● Generating creative text formats of text 

content, like poems, code, scripts, musical 

pieces, email, letters, etc. 

● Translating languages 

● Answering questions in a comprehensive 

and informative way, even if they are open 

ended, challenging, or strange. 

Google Bard is a factual language model from Google AI, trained on a massive dataset of text and 

code. It can generate text, translate languages, write different kinds of creative content, and 

answer your questions in an informative way, even if they are open ended, challenging, or 

strange. 

 

 

 

Here are some specific examples of 

how ChatGPT and Bard could be used in the classroom: 

● A teacher could use ChatGPT to generate personalized learning materials for each 

student, based on their individual needs and interests. 

● A student could use Bard to get help with their homework, or to prepare for a test. 

● A class could use ChatGPT or Bard to generate ideas for a creative project, or to research 

a topic for a report. 

● A teacher could use ChatGPT or Bard to create a quiz or test for their students. 

● A student could use ChatGPT or Bard to get feedback on their writing, such as an essay 

or a poem. 

● Overall, ChatGPT and Google Bard have the potential to be powerful tools for improving 

education. They can be used to personalize learning, help students learn new concepts 

and skills, encourage critical thinking and creativity, provide feedback and assessment, 

and engage students in active learning. 
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Self-Assessment 

Use these self-assessment statements to evaluate your basic internet proficiency after 
completing the learning session 

Skills Yes No 

Do I know what AI is?   

Do I know what major AI tools are?   

Do I know what ChatGPT is?   

Do I know what is Google Bard?   

Can I find relevant information using ChatGPT or Google Bard?   

I am proficient in composing and sending emails.   

I am skilled at attaching files to emails.   

I have acquired the knowledge to upload files to my Google Drive.   

I have acquired the knowledge to upload photos to my Google Photos.   

I can confidently conduct effective searches using Google by using 
keywords 
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Learning Objectives: 

 
 
Upon completing this session, participants will be able to proficiently 
demonstrate the following Microsoft Teams skills 

 
● Introduction to MS Teams: 

o Explain the purpose and importance of Microsoft Teams in 
Online Teaching. 

o Identify the key features and capabilities of Microsoft Teams. 
● Opening and Downloading Microsoft Teams: 

o Launch Microsoft Teams from various methods, including 
desktop shortcuts and the Start menu. 

o Downloading Teams Mobile App from Play Store. 
o Sign in Microsoft Teams using QAED credentials. 

● Interface of MS Teams: 
o Identify and describe the main components of the Microsoft 

Teams interface, including the Activity, Chats, Teams, Calls and 
Calendar. 

o Record the Teams meeting. 
● Join or Schedule Meeting: 

o Schedule or Join a meeting using Calendar. 
o Create and Share meeting link to Add participants  
o Use different meeting control options  

SESSION- 12 Introduction to Microsoft Teams           90 Minutes 
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Microsoft Teams is a communication platform developed by Microsoft. Teams primarily 
compete with the similar service slack, offering workspace chat, videoconferencing, file sharing 
and application integration.  

Teams can help you to 

▪ Schedule and Record audio and video meetings. 

▪ Easily share your screen with team members for detailed explanations. 

▪ Sharing files quickly. 

▪ Chat with meeting participants. 

▪ Integrate and use multiple apps within Teams platform. 

 

How to use MS teams? 

Method-1: We can use Microsoft teams from webpage by using 
▪ https://www.microsoft.com/en-us/microsoft-teams/log-in OR 

▪ https://www.office.com/?auth=2 

After clicking on any of the above link, Sign in into your Microsoft account by using your 
credentials (User name and passwords) provided to 
you by QAED. 

Method-2: We can use MS teams from Microsoft 
Teams Desktop App or Android App. 
 

We can install desktop app from MS Teams official 
webpage by using this link 
https://www.microsoft.com/en-us/microsoft-
teams/download-app. 

We can install android app from Play 
store by using this link 

https://play.google.com/store/apps/details?id=com.microsoft.teams 

After installation of app simply sign in with your Credentials provided by QAED. 

Introduction to Microsoft Teams      

 

https://www.microsoft.com/en-us/microsoft-teams/log-in
https://www.office.com/?auth=2
https://www.microsoft.com/en-us/microsoft-teams/download-app
https://www.microsoft.com/en-us/microsoft-teams/download-app
https://play.google.com/store/apps/details?id=com.microsoft.teams
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Interface of MS Teams 

There are different options available in MS Teams app like Activity, Chat, Assignments, Teams, 
Calendar, etc. 

How to create MS teams meetings? 

▪ Select Calendar, A new window will appear. 
▪ On top right corner there are two options to host a meeting. 

o Meet Now 

o New meeting 

▪ Meet Now option is used to host instant meetings. 
▪ New meeting is used to schedule a meeting for later. 

 

 

 

 

 

When you click on the New Meeting Option,  
a new window will appear. 

Extra Bit…! 

 #Join with an ID is used to 

join others meetings with 

an ID shared by hosts. 
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Complete the New meeting details and click on Save button. 

A meeting link will be created, and you can copy and share that link with other expecting meeting 
participants. 

 

 

 

 

Before Joining the meeting must check your Mic and Camera. 
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On clicking Join Now button your meeting will start. Other participants will join your meeting 
through meeting link you already shared with them. 

 

In meeting screen you will see different options to control and manage Teams online meeting. 

 

Chat option is used to chat with meeting participants during live meeting. 

People option is used to view all meeting participants and also used to change their roles and 
to manage mic control. 

Raise option is used to raise your hand during the meeting. If any participant wants to say 
something during the meeting then he/she will click on this option then Admin will allow 
him/her to say using mic.  
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React option is used to show your reaction using Emoji during the meeting.  

 

View option is used to select screen view among different screen views. 

Share option is used to share your screen with participants during live meeting. 

 

More option includes further different meeting control options. 

● Record and transcribed option is used to record Teams meeting. 
● Meeting Info option is used to view the meeting link, ID and Passcode. 
● Background effects option is used to change your background while using your camera. 
● Setting>>Meeting options – this option is used to manage different meeting controls like 

participants Mic, Cam on/off option. 
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These meeting options or visible only on 
Admin side. Participants cannot change and 
meeting setting during the meeting. 

● Here beaing an Admin you can 
mute/un-mute the mic of all the 
participants. 

● You can enable/disable the 
participants Camera from Admin 
side. 

● You can lock the meeting so that 
after a start of meeting no one can 
join the meeting . 

● You can also enable/disable the 
meeting chat and Reactions.  

Leave button is used to Leave or End 
meeting. Participants have only Leave 
option. 
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Microsoft Teams Mobile App allows you catch up on important Teams activity, even when you 
can't be at your computer. You can chat with colleagues/students, attend meetings, and even 
make and receive calls from your cell phone, all while you're on the go! Teams primarily compete 
with the similar service Slack, offering workspace chat and videoconferencing, file storage and 
application integration. The free version of Teams is available for anyone to use. 

How to use MS Teams App? 

Teams Mobile App is available for IOS and Android. To download the Teams mobile app, go to 
your mobile device and download it from the iOS App Store or Google Play Store. 

After downloading the Teams App Sign In using your QAED official account.  

 

Interface of MS Teams App   

Activity  Keep up with important Teams 
notifications by selecting activity or the bell 
icon. This will show you all the notifications 
relating to chats, calls, channel activity and 
more. With the Teams mobile app, you’ll 
never have to worry about missing 
notification when you’re away from your 
desk!  

SESSION-13 Microsoft Teams Mobile App     90 Minutes  
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Chat 

Send chat messages to your coworkers or students, even 
when you’re on the go! Click into any of your pre-existing 
chats to send a message or start a new chat using the new 
chat button. 

 

Teams 

Clicking the Teams button will give you access to all your 
teams and channels. 

 

Calendar 

Simply click the Calendar icon to see all your meetings. You can click on a meeting to join even 
when you’re away from your computer. Teams is also smart enough to remind you to join 
meetings that are already in progress when using the app.  

  

 

 

How to join a 
Teams 
meeting? 
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⮚ To create an instant meeting you simply click the Meet Now button. 

⮚ Add meeting participants using Add participants option or invite the participants 
using Share meeting invite option. 
 

 

To view different meeting control options click on the  icon. You will see here different 
options like chat, people, share, views and others. 

⮚ Chat option is used to make conversations, share links and files with the meeting 
participants during the live meeting. 

⮚ People option is used to view the list of the meeting 
participants. 

⮚ Share option is used to share your Screen, photos, 
videos, PowerPoint and whiteboard. 

⮚ View option is used to see different meeting views.  

⮚ Start recording option is used to record the meeting. 
 

Click on this icon to Start 

or Join the meeting 

Extra Bit…! 

We can join the meeting 

as a guest without 

signing in. 
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⮚ After attending the meeting you can Leave or End the meeting using  icon. 

 
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Learning Objectives: 

Hands on Practice 

Through Teams Mobile App start a meeting using Meet 

Now option and add minimum 3 participants in your 

meeting. 

Use the following options during the meeting. 

o Chat with the participants 

o Mute and Un-mute participants Mics. 

o Share your Screen. 

SESSION- 14 Effective Use of Social Media        90 Minutes 
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 Upon completing this session, participants will be able to  
 
● Understand various social media platforms and their unique features. 

● Learn how to navigate, use, and optimize your presence on these platforms. 

● Explore best practices for personal and professional use of social media. 

● Understand the potential risks and challenges associated with social media, 

including privacy and security concerns. 

 

Introduction to Social Media Applications 

In the ever-evolving landscape of communication and connectivity, social media applications 
have become integral part of our personal and professional lives. These platforms have 
revolutionized the way we interact, share information, and build communities in the digital age.  

Why educators and school leaders should learn about social media? 

Teachers and school leaders should have knowledge of social media for several reasons. First 
and foremost, social media has become a prominent communication and information-sharing 
platform for students and their parents. Understanding how to use social media effectively 
allows educators to engage with students and their families, fostering better communication and 
collaboration. Additionally, it enables them to monitor and address issues related to 
cyberbullying and online safety, ensuring a secure learning environment. Furthermore, social 
media can be a valuable educational tool, offering opportunities for teachers to enhance 
classroom learning, share resources, and connect with a broader educational community. So, a 
practical knowledge of social media is an essential skill for educators and school leaders to 
navigate the digital age effectively. 

What Are Social Media Applications? 

Social media applications, often referred to as "social networks" or "social platforms," are digital 
tools designed to facilitate online interaction, content sharing, and networking. They empower 
users to connect with friends, family, colleagues, and even strangers across the globe. Popular 
social media platforms include Facebook, Twitter X, Instagram, LinkedIn, and TikTok, among 
many others. 
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Facebook 

Facebook is widely considered as the most popular social network. Facebook is the third most 
visited website in the world after Google and YouTube. Facebook lets users share all kinds of 
content such as photos and videos. You can also share live broadcasts and albums. 

Uses of Facebook in Education 

When you begin to see Facebook as a potential educational tool, you will discover several 
ways to integrate this platform into your classroom. 

● Facilitate classmate connections. 
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● Use Facebook Live to provide additional help to students 

● Teach students digital citizenship skills. 
● Share educational content. 
● Make Global Connections 

● Provide direct communication with teachers 

● Facebook Page can be used for school promotions and admission campaigns. 

How to use Facebook? 

You will open www.facebook.com in your browser or download Facebook mobile app from Play 
Store. After that create your Facebook account using SignUp option. You can use your Gmail 
account or mobile no. for Facebook account creation.  

After creating your Facebook account Sign In with your account ID and password. 

Personalise Your Profile 

A profile is a place on Facebook where you can share information about yourself, such as your 
interests, photos, videos, current city, and hometown. To see your profile, click or tap your name 
or profile picture at the top of Facebook. 

If you want to update your profile for any reason later on, simply go to the ‘About’ section of 
your profile. Once there, you can fill in more details about yourself. You can add your education, 
job title and more. 

Having a well detailed profile will make it easier for your Facebook friends and audience to find 
you. 

  

http://www.facebook.com/
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Set Up Your Privacy 

One of the most important basics of Facebook is staying secure. Once you’ve created your new 
profile, you can make changes to your privacy 
settings. This will control who can view your 
profile and information you share.  

● To edit these settings, click on the 
‘Settings’ options. 

● Then, click on the ‘Privacy’ option and 
make your changes as you see fit.  

You can also control how other people can find 
you and make contact with you on Facebook. 

 
 
 
Facebook Features 

Facebook has a wide range of features. Few basic features are described below. 

Facebook Timeline 
Your timeline on Facebook is a ‘log’ of your activity in backwards-chronological order. You will 
be able to see your uploaded media and status updates on your timeline. Also, the photos that 
you were tagged in by your friends will also show up here. You can see updates from Facebook 
friends on your timeline and interact with them.  Facebook lets you react to posts and comment 
on them. You can also share the posts that you like most. If you feel like it, you can share posts 
and other content on your friend’s timelines too. 

 

Newsfeed 

Your newsfeed is unique to your own page. You will see posts from your friends and 
liked pages. Also, you will see ads from brands that you might be supporting or using. 
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You can change how your feed looks by managing your preferences. Select the ‘Settings’ menu 
and go to the ‘News Feed Preference’ option. You can choose whose content you see first and 
more. 

   

 

Facebook Status 

You can update your status by typing in the box that asks ‘What’s on your mind?’ and many 
Facebook users see it as a quick way to let everyone know what’s up in their lives. 

 

Status updates are short and quick. Many Facebook users like to share inspiring quotes this way. 

 

Facebook Stories 

Facebook Stories are a visual way to share content. You can share pictures and videos in a 
Facebook story. You can also watch the stories shared by your friends. A story is visible to users 
for one day (24 hours). 
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Going Live 

This feature allows Facebook users to share live broadcasts with their friends. You simply have 
to select the ‘Live Video’ option from the ‘What’s on your mind?’ button. 

Once select this option, you can write your description for your broadcast, add a feeling or 
activity and tag people. You can also add a poll. Once you’ve finished describing your broadcast, 
simply press ‘Go Live’ and you’re recording. 

Facebook Messenger  

This is Facebook’s chat feature and is all about sending messages to other users. For Mobile users 
Facebook messenger app is also available on play store. You can use messenger app, if you need 
to stay in contact with your friends while not using Facebook itself. 

You can also create group chats to involve a handful of people by selecting the ‘New Group’ 
option.  

Facebook Page 

A Facebook pages are places on Facebook where artists, public figures, businesses, brands, 
organizations and nonprofits organizations can connect with their fans or customers. When 
someone likes or follows a Page on Facebook, they can start seeing updates from that Page in 
their Feed. Pages have the basic same functions as Facebook profiles with the added ability to 
advertise and track performance. 
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WhatsApp  
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WhatsApp 

WhatsApp is part of Meta group. One of the most common social media app which is in use 
globally. It’s simple, reliable and free. 

Common Uses 

▪ Private messaging 

▪ Voice calls 

▪ Video calls 

▪ Group chats  
▪ Group calls 

and much more…. 

How to download WhatsApp? 

You can download it from Google Play store / Apple 
Store / Microsoft store (desktop windows app). 

Interface of WhatsApp 

(Version updated on 13thsep 2023) 
WhatsApp has simple interface which can be easily use 
by anyone.   

Here how it looks: 

Communities: This is first tab from left which enables you 
to create communities.                                

Chats: Chats tab shows your personal chats, group chats 
and communities announcements. 

Updates: Updates tab includes status and Channel options. 

Calls: Calls tab enables you to make voice or video calls. 

 

How to Start Chat? 

▪ Click  
▪ Select a contact to chat with. 
▪ Enter a message in the Message box to start chatting with the selected contact. 
▪ Press        to Send. 
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Things we can share in a chat: 
By clicking  the following options will 
appear: 

▪ Document 
▪ Camera (directly capture using camera) 

▪ Gallery (pictures and videos from gallery) 
▪ Audio (any audio file from mobile storage) 
▪ Location (Your current/Live location) 

▪ Contact (any contact from your contact list) 

▪ Polls (can create polls to take opinions, ask 
questions etc.) 

 
 
 
 
 
 
 

 

How to create a WhatsApp group? 

You can create a WhatsApp group with up to 1024 
participants. 

 

▪ Open WhatsApp> tap     > New group. 

▪ Alternatively, tap          > New group. 

▪ Search for or select contacts to add to the 
group. Then, tap the green arrow icon. 

▪ If your contact doesn’t have a WhatsApp 
account, you can choose to send them an 
invite link via SMS. 

▪  Enter a group subject. This will be the name of 
the group that all participants will see. 

▪ You can add a group profile picture by tapping 
the Camera icon. You can choose to use 
your Camera, Gallery, Emoji& 
Stickers, or Search Web to add an image. 
Once set, the icon will appear next to the group 
in the Chats tab. 

▪ Tap the green check mark icon when you're 
finished. 

 

 

 

Extra Bit…! 

 You can send Voice 

messages by pressing mic 

Icon          
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Above images show the process of creation of New WhatsApp group in a sequence (from Left 
to Right). 

Admin controls of WhatsApp group 

By default, all group participants can send messages and change group information including the 
group subject, icon, or description. 

Group admins can change settings to allow either only admins or all participants to edit group 
info, send messages or add people to a group. 

Steps to change group settings: 

▪ Open the group chat, then tap the group subject. 
● Alternatively tap and hold the group in the Chats tab. Then, tap More 

options >Group info   
▪ Tap Group Permissions  
▪ Tap “Edit group settings” to allow All participants or only admins to edit the group info. 
▪ Tap “Send messages” to allow All participants or only admins can send messages. 
▪ Tap “Add other participants” to allow All participants or only admins can Add 

participants in a group. 
▪ Tap “Approve new participants” to turn on and off this option. 

● When turned on, admins must approve anyone who wants to join the group. 
● When turned off, this group is open for people to join without admin approval. 
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How to add Participants in a Group: 

 

There are three ways to add a participant in a group 

after creation. 

▪ Click on add icon after taping Group subject. 

▪ Add using Add Participants. 

▪ Invite via link. 
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How to create WhatsApp Communities 

 
WhatsApp Communities is a new way to organize 
your WhatsApp groups under one umbrella and 
connect all sub-group members, which can be 
helpful if you have created different groups of 
different classes you, can connect all of them via 
communities. Every single announcement from 
admins will be sent to in all groups which are 
connected in a community. 
Steps to open a community: 

▪ Tap on the new communities tab at the 
top of your chats on Android.  

▪ You can then enter the community name, 
description, and profile photo. 

▪ You can Create a New Group or Add an 
Existing Group. 

 
 

 

  

 

 
 

 

When finished adding or creating groups, click the  

green check mark icon to create your community. 

  

Extra Bit…! 

 
In a community you can 

only add groups you 

created, not groups you 

are only a member of. 
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Updates Tab 

Updates tab is new home of WhatsApp Status.  

A new feature of Channels is also added in this tab. 

Status Privacy 

You can set privacy for your status. It means that you will  define who will be able to see 
your status updates and whom you have to restrict.  

 

Channels 

Get information and relevant updates directly in WhatsApp by following the channels of people 
and organizations that interest you. Follow a channel to get updates like text, links to information, 
photos, or videos from them. Only the creator can send updates in channels. 

WhatsApp Web 

WhatsApp Web is a popular method to use WhatsApp on computers. It lets you easily reply to 
messages and chat with your contacts while working on a desktop or laptop. 
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YouTube 

YouTube is a free video sharing website where you can watch videos and also like, share and 
comment other’s videos. You can even create and upload your own videos to share with others.  

How to use YouTube? 

You can simply open www.youtube.com in web browser and watch the videos of your choice 
any time. But to like or comment on any video you must be Sign In with your Google account.  

Use of YouTube as a Teacher/Leader 

● Teachers can show different educational videos relevant to the subject to their students, 
this will leads toward effective learning. 

● Teachers can create their own video and upload on YouTube channel where students 
can easily watch those videos online for learning any time.  

● School leaders can promote their school activities using YouTube to build up school 
repute in the society. 

How to create a YouTube Channel? 

A channel is a member's personal presence on YouTube, similar to other social media sites. To 
upload your own videos on YouTube, you have to create a Channel on YouTube. 

Here are the steps to create a YouTube channel. 

● Open www.youtube.com in web browser. 
● Sign In with your Google account. 
● Click on your account icon on the upper right corner of the screen as shown in below 

window. A short screen will appears. 

● Select Create a Channel option. 

 

 

Extra Bit…! 
Before Channel 

Creation must Finalize 

your Channel Name. 

http://www.youtube.com/
http://www.youtube.com/
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● After that a new window will appear, here you will type your channel name. 
● You can select handle of your own choice subject to the availability. 
● Click on Create Channel,  
● Your Channel will be created.  

 

● Now Open Your Channel by clicking on your account icon as shown in below screen 
and click on Your channel option. 
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● Your YouTube Channel will be opened. 

● To upload your video on YouTube channel click icon as shown in below screen. 
● Then click on Upload video option. 

 

● In new window click on SELECT FILES option and browse and select the video from 
your computer which you want to upload. 
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After selecting the video a new window will appear. 

● Type the Title (attractive name of the video) and Description of the video and select the 
thumbnail (picture shown on YouTube video) and click on Next button. 

 

● In new appeared screen again click on Next button. 
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● In below screen select Public option and click on SAVE button. 
● Your video will be uploaded on your YouTube channel. 

 

● Your video will be shown on your YouTube channel as shown in below screen. Here 
you can edit video Title, Description and Thumbnail any time.  

● You can also see the details of views, comments and likes here. 
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After uploading your video, you can share your video link with your friends, students and to 
anyone. 
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twitter /  
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Twitter / X    

X (formerly Twitter) is an online news and social networking site where people communicate 
in short messages.  

Common Uses 

Some people use X to discover interesting people and companies online, opting to follow their 
tweets. 

For Teachers & School Leaders 

Teachers and school leaders can get many educational ideas and news by following their 
favorite educationist and news agencies.  

Like all the other ministries of Pakistan, education ministries Federal and Punjab as well as 
QAED have their Twitter/X accounts. By following them we can stay updated with verified 
news and other developments in education sector. 

Posts / Tweets 

Everything you shared on Twitter/X is knows as Post (formerly tweet). A Post is limited to 280 
individual characters (letters, spaces, and punctuation marks) for non-verified users. However 
for paid users (blue tick holders) its 10,000 characters and they can also post long videos. 

Interface of Twitter/X 

Twitter/X has a simple interface, one can easily understand                   
after using few times. 

Sequence is as (at bottom from left to right): 

▪ Home: Where you’ll everything 
happening (posts). 

▪ Search: You can search across X 
(people or posts). 

▪ Communities: Posts from communities 
you’re part of. 

▪ Notifications: Notifications of all the 
activities                                      
(Likes, comments etc.) 

▪ Direct Messages (DM): You can send 
direct messages to people you’re 
following. 

 

Navigating to your Profile 
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To post anything click on the + icon.                  
Following options will appear:         

▪ Post 
▪ Gif 
▪ Photos 

▪ Spaces 

 

 

 

 

Post/Tweet Something 
To post anything click on Post. A new window showing What’s happening will appear, write 
anything or add photos, create polls, share location or add Gif then click Post. 

Before Posting following settings you may change: 

▪ Post will be Public or to share in a circle (specific people). 
▪ Everyone can reply or specific people or people you follow. 
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#Hashtags 
 

Hashtags are frequently used with posts and it’s a good 

practice to use relevant hashtags with your posts, it will 

increase your reach. People search specific topics using 

these hashtags.                  

 

 

   

 
 

Comment, Repost/Quote, Like & Sharing a Post 
There is a simple way to do all these above mentioned things. 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you want to pin your post (it will show on top of your post feed) or delete or change who can 
reply, Click on the three dots of your Post next to your username. 

Repost/Quote Comment Like Post activity 
Share/Copy Link 
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Edit option after you have posted is only available for paid users.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

SESSION- 15 

HANDS ON PRACTICE ACTIVITIES & EVALUATION TEST  
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Office of the District Education 
Officer 

District__________ 

 

 

To  

 The Chief Executive Officer (DEA), 
 Punjab. 
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Subject:  Result of Typing Test  

 With reference to your letter No. 476/ACCTT dated 30/10/2024 regarding the typing 

test for the promotion of Class IV employees as Junior Clerk. The said test has been 

conducted on 15/12/2023 and the result is attached herewith for your kind perusal. 

 

       

         

        Headmistress 

        Govt Girls High School _____ 
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Quaid-e-Azam Academy for Education Development 

Sargodha 

4-Days Training of ESE Teachers on Early Childhood Education (ECE) 

w.e.f. 09-04-2018 to 12-04-2018 

REGISTRATION FORM 

Name (as per Matric Certificate) ______________________________________ 

CNIC Number _______________________ Date of Birth ___________________ 

Designation______________________________ BPS _____________________ 

Qualification: Academic _____________________ Professional _____________ 

Present Place of Posting ____________________________________________ 

EMIS Code of ECE School _____________________ Mobile # _______________ 

E-mail __________________________________________________________ 

Residential Address _______________________________________________ 

         

_____________ 
Date _________________           (Signature) 
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Create a Presentation in Microsoft PowerPoint according to the given Format. 
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Beginners ICT Guide for Educators and School Leaders 
 

Quaid-e Azam Academy for Educational Development, Punjab  132 

Create a Salary Slip in MS Excel according to given format using different 

formulas or functions. 

● Auto calculate 15% of basic Pay medical allowance using formula 

● Auto calculate 20%  of basic Pay house rent using formula 

● Auto calculates Gross Salary and Total deductions using SUM function. 

● Auto calculate Gross Salary using formula 
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Create a Result sheet in MS Excel of class 8th. Calculate the total marks, 

percentage using formula.  

 

Result Sheet of Class 8th Iqbal 

Govt High School Kot Miani Faisalabad 

Roll 
No 

Name Eng Urdu Math G.Sci Isl S.Std Total 
mark
s 

Obtained 
marks 

%age 
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ADDITIONAL READING MATERIAL 

 

 

 

 

 

 

 

 

 
Digital Citizenship 

Societies are evolving with the passage of time. We use technology for communication instead 
of writing letters, sending faxes, or meeting with people. The Internet and smart devices have 
become an essential part of our daily routine. 
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The use of social media and the Internet is prevailing day by day. This massive increase in the 
use of digital means of communication resulted in increasing data security issues also.  

Let us also have a look at the safety aspects we need to consider to create a healthy cyber 
environment. 

 

● Internet 

The Internet is also called ‘the NET’ or ‘Network of Networks’, which means International 
Network. It is a network used all over the world where users located at different locations can 
communicate and exchange information with each other. It is a collection of networks that are 
connected and form a global network. 

The Internet provides you the services of online shopping, electronic banking, advertisement, 
data sharing communication, education, entertainment, etc. The Internet has transformed our 
lives and made us more digitized. 

Advantages of Internet 

The usage of Internet has increased over the years as it has many advantages. Let us 
discuss some of its advantages: 

● Treasure of Information 

Internet is a hub of information. We can search and access any type of 
information on any topic through the Internet. It is used extensively by people to 
do their projects and research. 

● Web Services 

Internet provides many useful services like chatting, email, video conferencing, 
etc. which help people to connect all around the world. Using these services, 
organizations can exchange information and conduct meetings with their 
employees which are located at different places. 

● Promoting Business 

Internet also helps companies to promote their products online through websites 
and social networking sites. It allows users to sell their products online. It also 
allows being in contact with the customer 24/7. 

● E-Learning 

Internet has changed learning from physical classroom to virtual classrooms. 
These days students can study by sitting at home in their comfortable timings. 
Internet is also used by teachers as well as students to collect information on 
various topics. 

● Entertainment 

Internet is used by people for entertainment. People can listen to music, watch 
movies, and play games on the Internet. The Internet allows people to read 
newspapers and magazines online. There are various services on the Internet like 
Newsgroups and Blogs where people can contribute as per their interests. 

● Internet Banking 

Conventional banking systems 
are getting obsolete now. 
Customers use their credit and 
debit cards for payments.  

Do You Know?  

Blogs are virtual diaries created by 

people to share their hobbies, thoughts 

with like-mined people. 
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Cash is withdrawn from ATMs (Automated Teller Machines) which are available 
24/7 all day and night. Mobile banking has taken the banking system to a high 
level. From your mobile phones, you can pay your bill, transfer money, pay for 
shopping, top up your mobile phone SIM cards, and many more. 

 Disadvantages of Internet 

The Internet has many advantages for users. But, as we know, excess of everything is 
bad. So, the Internet has some disadvantages too. 

● Violent Information 

Several websites on the Internet have violent videos and images. This type of 
content can disturb the mental health of children as well as adults. 

● Wastage of Time 

It is a waste of time as with the excessive use of Internet, people get addicted to 
it and spend a lot of time surfing without any useful outcome. 

● Virus and Spam Attacks 

Internet has also increased the cases of virus attacks. Users can lose their data 
and programs in these virus attacks. 

● Loss of Person Information 

We share our personal information over the internet that can be misused by 
cyber criminals to harm us. 

 

● Social Media 

The website or program known as Social Media is 
where users can share their content. Additionally, 
it facilitates online conversations with other users. 
Millions of people all over the world are actively 
using it because of its enormous popularity and 
usefulness. 

Advantages of Social Media 

Social media has a lot of benefits. 

o You can use it for educational purposes. 
o You can use it for entertainment. 
o It is easier to communicate and share information. 
o You can create your brand and content to share original material. 
o It is easier to get updated information and news. 

Disadvantages of Social Media 

Social media also has several drawbacks, but fewer than its advantages. Some of its 
advantages include: 

o It may also be the cause of a great deal of inefficiency. 
o Lack of privacy can lead to identify theft, stalking, and other problems. 
o As it is easy to get distracted from your work and loose focus when using social 

media, it may also be the cause of a great deal of inefficiency. 
o It can be quite damaging to not know how to respond to negative feedback and 

to become easily distracted. 
o Your shared data may be used against your after tempering it. 
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● Digital Media Bias and Messaging 

The idea that the media is reporting the news in a biased or partial way is known as media bias. 
When digital media looks to favor one point of view over another while covering the news, this 
is known as Digital Media Bias. 

We could use the example of the difference between two news broadcasters that have very 
different audiences. They tend to be biased in what they report and how they report it due to 
ideological and political views. 

Digital media is heavily used for messaging purposes as well. Many big platforms are used for 
messaging purposes as well. Some of them are: 

● Twitter 

● Instagram 

● WhatsApp 

● Facebook 

 
● Ethics and Ethical Use of Digital Environment 

Ethics 

At its simplest, ethics is a system of moral principles. They affect how people make decisions 
and lead their lives. Ethics is concerned with what is good for individuals and society and is also 
described as moral philosophy. 

Digital Environment 

The digital environment is an increasingly popular 
tool in family and child research that is argued to 
pose new ethical challenges. There are many 
issues in digital environments, such as: 

● Participant Privacy 

● Confidentiality 

● Anonymity. 

These concerns apply to internet research across all disciplines, not just those involving families 
and children. 

Ethical Use of Digital Environment 

If not handled ethically, using a digital environment can be dangerous. The following is a list of 
some ethical principles you should follow when using the digital environment: 

● Be respectful 
● Protect your reputation 

● Protect your privacy 

● Trustworthiness and honesty 

● Doing good and preventing harm 

● Avoidance of conflicts 

● Fairness 

● Accountability 

Identify Improper Use of Computer Resources 
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Everything has its boundaries. When that limit is violated, both you and other are at risk. The 
following are some examples of inappropriate computer resource use: 

● Actions that endanger people’s life or harm their property. 
● Actions that break the law. 
● Uses that breach information confidentiality. 
● Actions that encourage others to break the law. 

An employee using the company’s computer for personal use could serve as an example. The 
company prohibits its employees from using the company’s computer for personal benefit. A 
cyberbully is another example of the person who uses of computer resources improperly. He 
unlawfully stalks someone online and spreads hate against them using a computer. 

 

● Cyber Crime with Preventive Measures 

Cybercrimes are offences that are committed using computers and smart devices connected to 
the Internet. The victims of cybercrimes can be organizations or individuals. Most cybercriminals 
use e-mails, social media websites, or pirated software as a medium to trouble their victims. 

It is important to remember that data once shared over the internet is rarely deleted completely. 
Cybercriminals use this data unethically to trouble their victims. 

Let us discuss some of the most used ways to commit cybercrimes. 

E-mail Spoofing 

When someone sends e-mails that appear genuine from 
a trusted e-mail ID but, in reality they are not to be trusted. 
We call it E-mail Spoofing.  

For example, a user may receive an email from a 
portal or social media platform where the spelling 
of the service provider or email ID ahs been 
slightly changed.  

For example, mailto:customer@tridentportall.com. 

Notice that the spelling of ‘portal’ is incorrect. These emails contain links that will direct the user 
to another web page where the user would be asked to enter information which means the user 
ends up providing personal credentials to cybercriminals. This is also called Phishing. 

 
 

 

 

 

 

 

Spamming 

Do You Know?  
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It refers to the sending of bulk mail by an identified 
or unidentified source. Sometimes, certain 
businesses send bulk-advertising mail to many 
accounts at the same time. Some people 
intentionally send bulk mail to a user until the mail 
server runs out of disk space.  

Some people send virus-infected applications and 
files through the internet via emails, chats, games, 
etc. to get access to your smartphone and 
personal data. These emails may contain a 
document (Word or Excel file) with malware (a 
dangerous program that can impact your 
computer) attached to it. Opening such 
documents result in malware installed on your 
computer or mobile. 

Using reputable websites to download files and not opening doubtful e-mails are some ways to 
counter these threats. 

Some cybercriminals send emails informing the victim that they have won a lottery or a surprise 
gift. The cybercriminal then asks for personal details and bank details for transferring the winning 
amount. Cyber criminals may also ask the victim to deposit a small processing fee to lure the 
victim to transfer the winning amount. 

These emails are not to be trusted and one must not reply with any personal information. Further, 
these must be immediately deleted from the email account to avoid accidental access in the 
future. 

Measures to Avoid Spam 

To avoid spam, we can take the following measures: 

● Preview your message before opening them. 
● Do not click any link in a spam email otherwise, you will invite many such emails in 

your inbox. 
● Do not reply to a Spam email. 
● Do not forward an email receiving from someone you do not know to a list of people. 

Email account Hacking 

It is another common method used by cybercriminals 
to trouble victims. Using malware or other tricks to 
obtain your email ID and password, cybercriminals 
can gain access to your critical information like social 
media accounts, bank accounts, etc. Cybercriminals 
may also send offensive emails to a victim’s contacts 
via hacking. 

 

 
Do You Know?  

Cracking refers to the act of breaking into systems to steal or destroy data. Crackers may disturb 

applications by using malware or changing the program of the applications. 
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Measures to avoid Hacking 

To prevent unauthorized access to your computer and internet we can take the following 
measures: 

● Keep changing your passwords. 
● Keep updating your Operating System. 
● Do not plug into devices you are not sure about. 
● Always look at the green lock sign at the address bar of the window before accessing 

any website. 
● Always download trusted applications from the internet and check permission and 

authentication. 

Cyber Troll 

In Internet slang, a troll is a person who starts 
quarrels or upsets people on the internet to 
distract and create discord by posting mean and 
unwarranted messages in an online community. 

A cyber toll refers to a person who purposely 
posts opposing, sarcastic, demeaning, or insulting 
comments about something or someone. 

Social Engineering 

Social engineering is a technique used by cybercriminals to gain the information from individuals. 
Cybercriminals try to interact with the victims to understand their like and dislikes to seek 
personal information and/or commit some hard to them. 

Cyber Bullying 

Cyber Bullying refers to the use of the Internet, e-mail, instant messaging, chat rooms, or social 
networks, such as Facebook, Twitter, etc. to harass, demean, embarrass or intimidate someone 
else. 

Measures to prevent Cyber Bullying 

● Remember never to share personal details such as age, address, date of birth, etc. with 
unknown people on social media. 

● Restrict access to your data on social media platforms. For example, only your friends 
must be able to see any pictures on Facebook. 

● Try avoiding friend requests from unknown people on social media. 
● In case, any post hurts or upsets you talk about it to your trusted set of people like family 

or friends instead of posting aggressive replies. 
● If your parents/ elders feel the need, they can also contact the local police station to 

complain about the cyberbullying. 
● Never install unwanted software and applications like online games, etc. 

Do You Know?  

Verbal harassment is the most frequent kind of bullying, followed by social harassment, 

physical bullying, and cyberbullying. 
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Online Transaction Fraud 

Most of you may be using banking services such as debit cards, credit cards, net banking, etc. it 
is important to be aware of this type of cybercrime. 

Online transaction fraud refers to the illegal withdrawal or transfer of money from one bank 
account to another by a cybercriminal. Online transaction frauds generally take place when a 
cybercriminal stelas a user’s login credentials, bank account details, credit card details, etc. 

Types of Online Transaction Frauds 

Identity Theft: Sometimes, cybercriminals deliberately use another’s identity to gain a financial 
advantage over someone else. Cybercriminals may also pose as someone else to obtain credit 
and other benefits in the other person’s name. 

Job Frauds:  Cybercriminals portray incorrect details as an employer. 

Banking Frauds: Some cybercriminals fraudulently obtain money from users for 
investment by posing as a bank or other financial institution. 

Measures to Safeguard Ourselves from Online Fraud 

We can safeguard ourselves from online fraud by keeping in mind the following points. 

● Regularly update your banking passwords and PIN of the debit/credit cards. 
● Be sure to check for the bank’s security certificate details.  
● Also, check for various signs such as green address lines, lock signs or websites, and 

HTTPS in the address bar to confirm you are visiting a secure bank website. 
● Never share your bank and credit card details such as your online account password, 

card number, PIN, OTP, etc. with anyone. 
● Always check the website URL starts with HTTPS. The website URL with HTTPS encrypts 

your data on the website and protects it from any kind of tampering. 
● Avoid making online transactions using public Wi-Fi or a computer in a cybercafé. 
● Review the monthly statements of your bank account and credit cards to detect any 

unrecognized transactions. 
● In case the credit/debit cards are stolen or lost, call the bank immediately and block your 

card/bank account. 
● Never install pirated software on your mobile or computer. It is not only illegal but may 

also compromise the security of your devices. 
 

● Intellectual Property Rights 

Intellectual property is a term that refers to the legal property rights of a 
person over creations of his/her mind, both artistic and commercial. 
Under Intellectual property Rights, the owners of the property are granted 
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exclusive rights over their creation. These creations could be artistic, 
musical, or literary. 

Types of Intellectual Property Rights (IPR) 

There are three main types of Intellectual Property rights: 

Copyright: It is the legal right given exclusively to the person for a fixed number of 
years to publish, and record the literary, artistic, musical, or musical use 
of his or her work. Copyright of work lasts even after the death of the 
originator. 

Patent: It is the right that gives an inventor the complete right to make, use, and 
sell his or her work for a specific time period. Usually, the validity period 
for a patent is 20 years. 

Trademark: It is a symbol, word or logo legally registered or established and used as 
representing a company or a product. Trademarks help to protect brand 
names, logos, and the design of the product. The validity period of a 
Trademark is 10 years and can be renewed after that. 

Measures to Protect Intellectual Property rights 

We can take the following measures to protect Intellectual Property Rights: 

● Do not share your business ideas with others. 
● Have detailed drawings, descriptions, plans, and records that can prove it is your 

creation. 
● As soon as you have a business name and logo for your idea, you should register 

those Trademarks right away. 
 

● Plagiarism 

It refers to the usage or imitation of the language and thoughts of another person projected as 
one’s original work. It is considered a crime or fraudulent act. 

Plagiarism as described by the Merriam-Webster dictionary is as follows: 

● To steal and pass off ideas or words of another as one’s own. 
● To use another’s production, without crediting the source. 
● To commit literary theft. 
● To present as new and original, an idea or product derived from an existing source. 

Ways to Prevent Plagiarism 

Some of the ways you can prevent plagiarism are: 

● Use Citation-Citation refers to acknowledging the original writer and the source from 
where the material has been taken. 

● Rephrase the matter. 
● Use “ “ for statements quoted by another person. 
● Encourage original ideas and use authentic resources. 
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● Virus 

A virus is a type of software or malware that spreads between several computers and corrupts 
data. It targets the computer’s data and software. Its primary goal is to disrupt or interfere with 
the systems so that data can be corrupted or even leak. 

Some indications of a virus attack are listed down: 

● Unwanted pop-ups that repeatedly appear. 
● Modifications to your desktop or files. 
● The system speed slows down and suddenly crashes. It can also make the computer 

shut down itself. 
● You keep being logged out of your account. 
● It sends out mass emails from your account to infect other machines with viruses. 

Malicious activities are those that aim to compromise or corrupt the confidentiality of data or 
software in computers. There are numerous further varieties of malware and computer viruses. 
Some of the most common ones include: 

Ransomware: It makes the victims’ file inaccessible by disabling them. Once the ransom is paid, 
only then can they be accessed. 

Spyware: It gathers information about the victims without their awareness. The information 
is then utilized to their benefits. 

Malware for Mobile devices: This malware harms mobile devices through phishing and 
other means. 

Keyloggers: They record the victims’ keystrokes. It gathers private information or sensitive 
data like passwords. 

● Cyber Safety 

Cyber safety refers to the safe and responsible use of the Internet in order to safeguard one’s 
personal information while not misusing anyone else’s personal information. 

We can take the following safety measures while using the Internet or computer: 

● Install the most recent antivirus software on your computer. 
● Use caution when entering your password on the internet. 
● Do not respond to shady emails or strangers. 
● Do not disclose your personal information to anyone online. 
● Refuse friend requests from unfamiliar people. 
● Always leave your privacy settings on. 
● Be cautious when downloading. 
● Be careful what you post on social media platforms. 
● Encryption can be used to protect data privacy while transferring files between locations. 

 

● Ethical Hacking 

Not all hacking is destructive. Some hackers use this 
technique for national security, creating safer systems, 
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etc. This is known as ethical hacking. It is a legitimate 
practice to uncover potential data breaches and risks 
in a network or system. In order to find vulnerabilities 
that malicious hackers can exploit or eliminate, ethical 
hackers search the system or network. 

 

 

 

 

 

 

 

Keyboard Shortcut Keys A TO Z 

These shortcuts can save time and make working with text and documents more efficient. 

Ctrl+A : Select all text 

Ctrl+B  : Bold text. 

Ctrl+C : Copy tex.. 

Ctrl+D : Open font formatting window 

Ctrl+E  : Center text 

Ctrl+F  : Find a phrase 

Ctrl+G : Go to a specific page 

Ctrl+H : Replace text with another text 

Ctrl+I  : Italicize text 

Ctrl+J : Justify text 

Ctrl+K : Open insert hyperlink window 

Ctrl+L : Left align text 

Ctrl+M : Indent a paragraph from the left 

Ctrl+N : Open new document or file 

Ctrl+O : Open an existing document or file 

Ctrl+P : Print a document 

Ctrl+Q : Remove paragraph formatting 

Ctrl+R : Right align text 

Ctrl+S  : Save the document or file 

Ctrl+T : Create a hanging indent 

Ctrl+U : Underline selected text 

Ctrl+V  : Paste any text or object that has been copied. 
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Ctrl+W : Close open tab in a browser or a document in Word. 

Ctrl+X  : Cut text or object. 

Ctrl+Y :  Redo any undo action. 

Ctrl+Z : Undo any action 

 


